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INTRODUCTION TO PHOTOSHOP LAYERS BY MICHAEL SMYTH
Layers are one of the most important tools for working in Photoshop.
If you are not using layers you are missing out on most of the creative power available in
Photoshop !
WHAT ARE LAYERS ?
Layers are a way of making local or selective adjustments to an image. Layers are also a way of
applying adjustments to the whole of an image non destructively.
Local or selective adjustments are changes made to a part of the image only, whereas “Global”
changes apply to the whole of the image. Without layers you are pretty much restricted to global
changes to your image, apart from things like cloning.
Layers allow us to control how adjustments are applied to the base image. We will explain this later in the
Blending Modes section.
Layers are separate from the image and sit over the top of the base image (background). Imagine a
clear sheet of plastic placed over your image containing instructions on how each pixel below is to be
treated, in a similar way to a filter placed over the lens of your camera.
Layers contain sets of instructions that tell Photoshop how to
alter the underlying image information. Layers can be:
A duplicate of the original layer – used to apply artistic filters
or other treatments to the entire image (with reduced
transparency and/or altered blending).
An adjustment layer - a layer that is used for adjustments to
parts of an image, ( levels, curves, saturation etc).
Or a fill layer that is used to apply a pattern, colour or texture
to an image.
A layer comprises three components:
1. The layer itself containing the instructions (adjustment,
filter etc),
2. A layer mask that determines where the adjustment is to
be applied, and
3. The blending modes that determine how the adjustment is to be applied.
The blending modes are made up of a set of options:
The blending mode, the transparency of the layer, and the Layer Styles.
We will cover all of these in detail later.
Tip: Never, ever apply any adjustments to your base image. Always apply adjustments with adjustment
layers. Why ? successive adjustments to the base image can quickly degrade the image data so that
details are lost and colours pushed out of gamut. By using layers you can see the cumulative effect of
your adjustments and make fine adjustments accordingly to maintain your image quality and keep it in
gamut.
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WHY ARE LAYERS USED ?
Layers are a non destructive way of applying image adjustments as they do not affect the original pixel
values until the image is flattened.
Layers can be adjusted again and again until (and if) the image is flattened (the layer information is
combined with the base image).
Layers allow us to apply image adjustments selectively and reversibly to the base image by means of the
layer mask and blending modes.
Layers can be built up in multiples to allow the widest possible range of creative input into the image.
HOW DO WE APPLY LAYERS ?
Firstly ensure you have the layers palette visible by going to “Window” on the menu bar and checking
that the “Layers” palette is ticked.
Layers are applied to an image in either of two ways:
1.
Or
2.

By going to the menu bar and selecting: Layer> Duplicate layer, or Layer>New Adjustment layer,
or Layer>New Fill layer.
More simply by going to the layers Palette and clicking on the half black and half white circle
icon. This opens a menu bar that lists options for fill and adjustment layers. Choose the type of
layer you want to use.

To create a duplicate of the background (your base image) simply click on the layer shown inside the
layers palette (a thumbnail with an eye symbol to the left and called “background”) and drag it to the
square icon at the bottom with a folded over corner.
This creates a duplicate of your base image, ready to apply a special or artistic filter. When you create a
new adjustment layer, you will choose the type of adjustment you want to make: Levels, Curves, Hue
Saturation etc.
By clicking on the type of layer you want, a menu box opens to allow you to make that adjustment. Let’s
say we are going to use Curves to alter the tone mapping of the image. When you select this adjustment
the curves menu opens and you can make an adjustment as usual, with the image being updated in
real time to allow you to see the effect. When you are happy, click OK and the new layer is created.
In CS4, we now have the Adjustments Palette that allows us to create
an adjustment layer in one simple click.
The Adjustments palette is shown on the left. To create a new
adjustment layer, simply click on the icon (hover your mouse over to
see a description) for the type of adjustment you want to make. A
new layer complete with a mask is created.
These new tools in CS4 also allow for “live” (non modal in Adobe
speak) adjustments to layers without having to lock in each
adjustment before you move onto the next one as we had to in CS3
and earlier versions.
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THE ELEMENTS OF THE LAYERS PALETTE
Looking at the layers palette, you will now see a new layer above the background layer with an icon
showing the type of adjustment (either a thumbnail of the type of adjustment or a black/white symbol – if
all you see is the black/white symbol, right mouse click on the body of the layers palette and select small
or medium thumbnails as the option).
Next to the adjustment type icon will be a white rectangle.
This is the Layer Mask. On the right hand side of the layer
mask is the name of the adjustment layer. You can rename
the layer by double clicking on the default name and typing
in a name of your choice.
On the left of the layer icon is an eye symbol. When the eye
is visible, the layer is turned on. To turn it off, simply click on
the eye and it disappears. By turning the layer on and off
you can see the effect of your adjustment.
Click on the new adjustment layer and make sure the eye
symbol is visible. Now look at the top of the layers palette.
You will see directly under the layers tab a drop down box.
This is the Blending Mode options box. By default when you
create a new layer it is set to “Normal” blend mode. By
clicking on the downward facing arrow on the right hand
side of this box you will see all of the blending options to
choose from. We will cover these shortly.
At the right hand side of the blending mode options box is the Opacity options box. By default a new
layer is set to 100% opacity. To change the opacity, click on the arrow at the right hand side of the box
and either type in a new value, or drag the slider that appears to a new value. Remember that 0%
opacity means it is transparent and 100% means the layer is totally opaque and the adjustment is at full
strength.
By right mouse clicking (or double clicking) on the layer you are working on, a new menu pops up with a
number of options. Click on the Blending Options to access the Layer Styles and Advanced Blending
Modes menu box. This is where blending based on luminosity ranges can be made.
FINE TUNING ADJUSTMENT LAYERS
If you want to make a further adjustment to the adjustment layer, simply double click on the adjustment
layer icon to reopen the menu box and carry out the further adjustments. When finished, click OK. This is
repeatable as often as you want.
If using CS4, you need merely to click on the layer to reveal the adjustment in the Adjustments panel
above, make your changes and then move on to the next step you want to take.
If you have made a duplicate layer and applied an “Artistic” filter, the only way you can fine tune this
layer is to adjust the blending mode and transparency. By default when you create a duplicate layer, or
drag another image onto the background, no mask is applied. You can however add a mask to a
duplicate layer by clicking on the “add layer mask” icon at the bottom of the layers palette (it looks like
a circle inside a rectangle). By first selecting the layer you want to apply the mask to, simply click on this
icon to add a mask, then paint on or apply a selection as you want.
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If you have version CS3 or later, you now have the option of converting the layer to a “Smart Object” If
you want to take advantage of this option you must first duplicate the background layer (as above) and
then by right mouse clicking on the new layer select “Convert to Smart Object” Before you apply the
filter. The filter then appears as a separate item below the background copy layer. This can be re edited
by double clicking on the name of the filter and then making the adjustment required before clicking on
OK. Note that the layer mask now appears under the layer and the type of filter as a separate item
below that again.
Tip: When using an “Artistic” filter, always duplicate the background and apply the filter to the
background copy layer. Then reduce the transparency of this layer until the effect is reduced in strength
sufficiently to be useful and not overpower your image.

WORKING WITH THE LAYER MASK.
By default, when you create a new Adjustment or fill layer, a mask is applied that allows the adjustment
to apply to the whole of the image. White sections of the mask mean that the adjustment is applied to
that part of the image. Black parts of the mask mean that adjustments do not apply to that part of the
image. “White reveals, Black conceals” is an easy way to remember what the mask does.
So, if we want to be selective about where this adjustment is applied to the base image, we need to
change the mask. There are several ways to change the mask, but first the layer must be visible (eye
open) and next you must click once on the layer mask icon (white rectangle) to select this as the area
you are going to work on.
Once the layer mask is selected you will see a second outline around the icon indicating this is where you
are working.
The simplest and most effective way to change the mask is to paint on it with either black or white (these
are the only options). To paint on the mask, first go to the tools palette on the left of the desktop. Make
sure that the foreground and background colours are set to black and white. You will see a black square
and a white square. The one on top is the active one you will be using. If you don’t have black and
white visible, click on the small black and white icon directly above the colours to reset to the default
colours, or simply type “D” to reset them. To change from black to white and back again, click on the
two ended arrow above the foreground/background box (or type “X” to swap between them).
Tip: When you want to apply an adjustment layer to a small part of the image only, first convert the mask
to black by clicking on the mask and then holding down the Control key and then the Delete key. This
converts the mask to black. Alternatively, select black and choose the paint bucket, Then click
anywhere on the image to fill the mask with black (make the adjustment transparent). Then choose a
brush and select white to paint in the effect. Simple !
Next you need to choose a paint brush to paint in the black or white onto the mask. Select the brush tool
from the left hand side toolbox. An options bar will appear at the top of the image box under the menu
bar. Chose the size of the brush and softness from the drop down box. It is always best to work with a soft
edged brush to keep the transitions at the mask edges smooth. If you want to paint in (or out) in stages,
reduce the opacity to around 50%, otherwise leave at 100%.
To paint on the mask, first zoom in on your image and then paint on the image areas you want to include
or exclude from the adjustment. Remember to ensure the layer mask icon is still selected. If your image
suddenly changes to white or black as you paint, STOP, go to the history tab and click on the last step
before you started painting, or go to Edit>Udo on the main menu bar. Then click on the Layer mask and
start again.
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Tip: To quickly change the size of the paintbrush, simply use the bracket keys on the keyboard “[“ makes
the brush smaller and “]” makes it larger. If you only see a crosshair on your image, click on the “Caps
Lock” key to change to the round cursor to easily see where you are working.
If you accidently paint onto an area you don’t want, simply reverse the colour (“X”) and paint it back in
or out. This is completely reversible and re editable.
A further way to modify the mask is to apply a Gradient Fill to the mask using the gradient fill tool, located
with the bucket tool. You have several options for the type of fill and direction that can be accessed
from the toolbar at the top of the image area. Make sure you are working with Foreground to
Background colours and then choose the type of gradient. Apply the gradient by clicking and dragging
across the image area in the direction you want the gradient to be applied. This can be further refined
with the paintbrush as above.
Tip: Another easy way to see where you are working on your image is to make the adjustment much
stronger then you really want, then as you paint in or out on the mask, you can easily see where the
adjustment is being applied. When complete, simply double click on the adjustment layer icon and fine
tune the adjustment. Alternatively, reduce the opacity.

Tip: To make an adjustment layer apply to the immediate layer below only, right mouse click on the layer
and choose “create clipping mask” from the drop down menu. A small downward pointing arrow
appears next to the layer thumbnail to show that it applies to the layer below only.

APPLYING SELECTIONS TO MASKS
An alternative way to modify the layer mask is to make a selection on the image before you create the
adjustment layer. The selection is automatically applied to the layer mask when the new layer is created.
If you have already created the new adjustment layer you can delete the existing layer mask by right
mouse clicking on the layer mask and choosing “Delete Layer Mask”. Next make your selection
(remembering to feather as required) and then, making sure the correct layer is active (highlighted) on
the layers palette, then click on the “Create Layer Mask” icon on the bottom of the layers palette (this
looks like a white circle inside a rectangle). The selected area becomes the white part of the mask.
You can then modify the mask with the paintbrush tool as above.
Layer masks can be worked over again and again with the paintbrush and/or gradient fill tools. This
process is completely reversible and non destructive.
Layer masks can be further refined by using the Levels tools, curves tools or the blur filter. Refer to the
other tutorials on this site for more information.
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WORKING WITH THE BLEND MODES
The following blend modes are available from the drop down menu at the top of the layers palette.
These are divided into six groups: The Independent Modes, The Darkening Modes, The Lightening Modes,
The Light or Contrast Modes, The invert or Comparative Modes and the HSL Modes.
The following information is extracted from the Help menu in Photoshop:
Independent Modes:
Normal: Edits or paints each pixel to make it the result colour. This is the default mode.
Dissolve: Edits or paints each pixel to make it the result colour. However, the result colour is a random
replacement of the pixels with the base colour or the blend colour, depending on the opacity at any
pixel location.
Darken Modes:
Darken: Looks at the colour information in each channel and selects the base or blend colour—
whichever is darker—as the result colour. Pixels lighter than the blend colour are replaced, and pixels
darker than the blend colour do not change.
Multiply: Looks at the colour information in each channel and multiplies the base colour by the blend
colour. The result colour is always a darker colour. Multiplying any colour with black produces black.
Multiplying any colour with white leaves the colour unchanged.
Colour Burn: Looks at the colour information in each channel and darkens the base colour to reflect the
blend colour by increasing the contrast. Blending with white produces no change.
Linear Burn: Looks at the colour information in each channel and darkens the base colour to reflect the
blend colour by decreasing the brightness. Blending with white produces no change.
Darker Colour: Compares the total of all channel values for the blend and base colour and displays the
lower value colour. Darker Colour does not produce a third colour, which can result from the Darken
blend, because it chooses the lowest channel values from both the base and the blend colour to create
the result colour.
Lighten modes:
Lighten: Looks at the colour information in each channel and selects the base or blend colour—
whichever is lighter—as the result colour. Pixels darker than the blend colour are replaced, and pixels
lighter than the blend colour do not change.
Screen: Looks at each channel’s colour information and multiplies the inverse of the blend and base
colours. The result colour is always a lighter colour. Screening with black leaves the colour unchanged.
Screening with white produces white. The effect is similar to projecting multiple photographic slides on
top of each other.
Colour Dodge: Looks at the colour information in each channel and brightens the base colour to reflect
the blend colour by decreasing the contrast. Blending with black produces no change.
Linear Dodge (Add): Looks at the colour information in each channel and brightens the base colour to
reflect the blend colour by increasing the brightness. Blending with black produces no change.
Lighter Colour: Compares the total of all channel values for the blend and base colour and displays the
higher value colour. Lighter Colour does not produce a third colour, which can result from the Lighten
blend, because it chooses the highest channel values from both the base and blend colour to create
the result colour.
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Light or Contrast Modes:
Overlay: Multiplies or screens the colours, depending on the base colour. Patterns or colours overlay the
existing pixels while preserving the highlights and shadows of the base colour. The base colour is not
replaced, but mixed with the blend colour to reflect the lightness or darkness of the original colour.
Soft Light: Darkens or lightens the colours, depending on the blend colour. The effect is similar to shining a
diffused spotlight on the image. If the blend colour (light source) is lighter than 50% gray, the image is
lightened as if it were dodged. If the blend colour is darker than 50% gray, the image is darkened as if it
were burned in. Painting with pure black or white produces a distinctly darker or lighter area, but does
not result in pure black or white.
Hard Light: Multiplies or screens the colours, depending on the blend colour. The effect is similar to shining
a harsh spotlight on the image. If the blend colour (light source) is lighter than 50% gray, the image is
lightened, as if it were screened. This is useful for adding highlights to an image. If the blend colour is
darker than 50% gray, the image is darkened, as if it were multiplied. This is useful for adding shadows to
an image. Painting with pure black or white results in pure black or white.
Vivid Light: Burns or dodges the colours by increasing or decreasing the contrast, depending on the
blend colour. If the blend colour (light source) is lighter than 50% gray, the image is lightened by
decreasing the contrast. If the blend colour is darker than 50% gray, the image is darkened by increasing
the contrast.
Linear Light: Burns or dodges the colours by decreasing or increasing the brightness, depending on the
blend colour. If the blend colour (light source) is lighter than 50% gray, the image is lightened by
increasing the brightness. If the blend colour is darker than 50% gray, the image is darkened by
decreasing the brightness.
Pin Light: Replaces the colours, depending on the blend colour. If the blend colour (light source) is lighter
than 50% gray, pixels darker than the blend colour are replaced, and pixels lighter than the blend colour
do not change. If the blend colour is darker than 50% gray, pixels lighter than the blend colour are
replaced, and pixels darker than the blend colour do not change. This is useful for adding special effects
to an image.
Hard Mix: Adds the red, green and blue channel values of the blend colour to the RGB values of the
base colour. If the resulting sum for a channel is 255 or greater, it receives a value of 255; if less than 255,
a value of 0. Therefore, all blended pixels have red, green, and blue channel values of either 0 or 255. This
changes all pixels to primary colours: red, green, blue, cyan, yellow, magenta, white, or black.
Invert or Comparative Modes:
Difference: Looks at the colour information in each channel and subtracts either the blend colour from
the base colour or the base colour from the blend colour, depending on which has the greater
brightness value. Blending with white inverts the base colour values; blending with black produces no
change.
Exclusion: Creates an effect similar to but lower in contrast than the Difference mode. Blending with
white inverts the base colour values. Blending with black produces no change.
HSL Modes:
Hue: Creates a result colour with the luminance and saturation of the base colour and the hue of the
blend colour.
Saturation: Creates a result colour with the luminance and hue of the base colour and the saturation of
the blend colour. Painting with this mode in an area with no (0) saturation (gray) causes no change.
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Colour: Creates a result colour with the luminance of the base colour and the hue and saturation of the
blend colour. This preserves the gray levels in the image and is useful for colouring monochrome images
and for tinting colour images.
Luminosity: Creates a result colour with the hue and saturation of the base colour and the luminance of
the blend colour. This mode creates the inverse effect of Colour mode.
Listing all of these blending modes may seem a little over the top, however in practice you only really
need to worry about a few that are the most often used.
Typically the most commonly used blend modes are: Normal, Lighten, Darken, Overlay, Soft Light and
Luminosity
Tip: If you are using adjustment layers for levels, curves or brightness /contrast adjustments, use
“Luminosity” as the blend mode to avoid introducing colour shifts to your image.

WORKING WITH OPACITY (TRANSPARENCY)
Adjusting the opacity or transparency of a layer is a lot simpler to follow than the various blend modes
and is often the most commonly used of the blending options.
If you are using “artistic” filters – and by that I mean any one of the myriad of special effects found under
the “Filter” menu, you should be reducing the transparency of these filters as a matter of course. The
filters available in Photoshop are interesting and can be effective in realising your vision, but they are
overpowering if used in an undiluted form.
Tip: When working with adjustment layers I often make the adjustment greater than I really want and
then fine tune it with the transparency as it is adjustable over a wide range (0- -100%).
To adjust the transparency, simply click on the Opacity arrow next to the existing value (default 100%). A
slider appears which you can drag with your mouse with the effect visible as a live preview. Alternatively
you can highlight the existing value and type in a new value between 0 and 100%.
WORKING WITH LAYER STYLES
The “Layer Styles” options are a little less
obvious than the transparency and blend
modes, however here is where you will find
the special treatments you can apply to
layers such as: bevel and emboss, drop
shadows etc. these are useful for text, but
the main interest to us is in the “Advanced
Blending Options”. To access these options,
right mouse click on the layer of your
choice (not on the thumbnail or layer
name) and click on Blending Options. A
new menu box opens with the General and
Advanced Blending box open.
Here you can select the blending of the
layer based on the luminosity values of the
layer, without the need to make a mask.
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To access these controls, ignore the top part of the menu box and go to the bottom section labelled
“Blend If”. By default the mode is set to “Grey”. Leave this as is and go straight to the sliders beneath the
box (You can blend by colour channel, but that is beyond our scope here).
The top slider called “This Layer” controls which brightness values from the adjustment layer will be
blended with the layers below. The bottom slider, labelled “Underlying Layer” controls which brightness
values from the layers below will be blended into the final “mix”.
For simplicity, we are only going to adjust which brightness values from the top adjustment layer are
going to be blended. A good example of when to use this is if you want to lighten all of the shadow
areas in an image without having to mask them.
Create an adjustment layer on an image with deep shadow areas. Set the curve on the adjustment
layer to an upwards curve in the middle. This acts to brighten the tones in the middle of the image, with
only the very dark and very light values unaffected. Look at the image and ignore the bright areas for
now, manipulate the curve until the shadow areas are opened up without looking washed out. Click OK
to accept the adjustment.
Click on the newly created adjustment layer (NOT on the image thumbnail, the mask, the adjustment
layer name or the adjustment icon) and either right mouse click or double click to access the Layer Style
menu box.
By default you will come to the “Blending Options” menu. Go straight to the Blend If box and click on the
white triangle under the “This Layer” slider. Drag it to the left. You will see the lighter tones get darker as
the blending is applied, however there is a nasty posterised effect now visible. Once you have moved
the slider to the point where the lightest tones are unaffected by the adjustment layer, move your mouse
carefully to the left hand side of the triangular slider. Holding down the “Alt” key, drag the left hand part
away to the left.
Separating the slider acts as a feathering area where instead of an abrupt cut off where the tones are
blended or not, creates a smooth transition. The wider apart the two halves of the slider, the greater the
feathering.
Tip: Using the blending options can save a lot of time in working on the mask if you are working on very
dark or very light areas that are difficult to select.

AND FINALLY
There are many more tools that make working with layers even more powerful and more creative, but
take the time to master the basics of layers and you will have access to the most important part of
Photoshop.
As all of these techniques are non destructive, you can experiment as much as you like without risking
damaging your base image.
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